
At last!  LAMBDA and the LAMBDA helper functions are now Generally 
Available to anyone using Production: Current Channel builds of Excel.  
In conjunction with LAMBDA going to production, Microsoft has 
also announced the release of a new add-in, the Advanced Formula 

Environment, which allows simpler importing, exporting and authoring 
of named LAMBDAs.
As a reminder, LAMBDA allows you to define a custom function in Excel’s 
very own formula language.

To show how LAMBDA and the Advanced Formula 
Environment might work together, let’s look at an example 
that Microsoft use for simplicity: IFBLANK.

Now, no such function exists in Excel – but now, it can.  
Many regularly encounter issues replacing certain values in a 
dataset, such as errors or blanks cells.  Excel provides IFERROR 
to replace error values, but there is no function to replace 
blank cells.  However, with LAMBDA, you may now build your 
own IFBLANK function.  

Now you may author this in a worksheet and then import it 
into the Name Manager, but you may also create this in the 
new formula environment and then synchronise it with the 
Excel workbook to make use of it therein.
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At last!! LAMBDA finally makes it to Office 365 Current Channel, so those of you on the subscription model can finally see this 
powerful function in all its glory.  It even has a new interface.  We detail more inside this month’s newsletter.

But that wasn’t the only news item this month: we have an update on Excel 4.0 macros, there is now AutoComplete for dynamic data 
validated dropdown lists, plus we itemise other useful improvements for Excel for the Web.  

Also, Power BI returns with a vengeance this month and keeps our regulars company: there is another Beat the 
Boredom Challenge, plus our usual articles on Charts & Dashboards, Visual Basics, Power Pivot Principles and 
Power Query Pointers.  We also have an IMAGINARY A to Z of Excel Functions, we even see what’s LEFT in our 
Keyboard Shortcuts.
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Advanced Formula Environment

To facilitate the new, improved LAMBDA in a Current Channel production environment, a new tool to aid in the authoring of more complex named 
formulae has been created.  The Advanced Formula Environment (AFE) is a space where you may explore new and different methods for authoring 
formulae with special functionality designed with LAMBDAs and LET in mind.

This new tool includes the following features:

	 •	 advanced formula authoring capabilities:
		  o	 IntellisenseAA
		  o	 commenting
		  o	 in-line errors
		  o	 auto tabulation
		  o	 code collapse
	 •	undo / redo of formula edits within the manager
	 •	 namespaces to allow for groups of named functions
	 •	 import and export functionality
	 •	 text and GitHub Gist import
	 •	 different views to filter your names and edit in a single location.

The environment is available on all platforms where Office Add-ins are available (i.e. Mac, Windows and the Web).

There are two views presently in this tool: Manager and Editor views.

Think of the Manager view as similar to Excel’s Name Manager, but with more functionality.  This is where you will see all of your names with their 
own individual cards and associated quick actions.  There are four key actions

Without IFBLANK, Excel, by default returns a blank which gets coerced to 
zero [0] when placed in the cell.  Not anymore.

Furthermore, Microsoft has added support for function ToolTips for 
named LAMBDAs in addition to auto-completing the open parentheses 
character when calling these functions, i.e. calling a function defined 
using a LAMBDA is now exactly the same as calling a native function.

Also, Microsoft has increased the limit of recursion by 16 times its 

original limit, i.e. Microsoft has increased the limit of recursion by 16 
times its original limit, i.e. Microsoft has increased the limit of recursion 
by 16 times its original limit…

The way the LAMBDA helper functions handle arrays of references 
differently now too.  Previously when a LAMBDA helper function returned 
an array and the associated LAMBDA returns a single cell, an #CALC! 
error would be returned.  This has now been modified to automatically 
return the cell value as the output of the LAMBDA function.

Icon Description

Edit the name

Rename the formula

Delete the entry

Export the definition for sharing
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On the other hand, the Editor is where you can go to edit all entries 
within the workbook or create new namespaces for collections of 
formulae.  This is where you will most likely go to create more complex 
functions, since you get the full version of the Editor in this view and may 
create multiple names sequentially.

The workbook section contains all names which are not attached to a 
given sheet but instead are saved globally in the workbook.

The Advanced Formula Environment can import definitions into the 
manager.  You can important individual definitions as well as libraries 
of definitions via text or through GitHub Gists.  The main entry point for 

importing can be found by selecting the action in the actions bar. The 
main entry point defaults to “From URL” but the dropdown reveals the 
“From text” option.

Accessibility

To get access to LAMBDA functions, please make sure you have updated to the latest version of Excel.  LAMBDA is now available to Office 365 
Subscribers in Production: Current Channel.  Versions must be greater than or equal to:

	 •	Windows: 16.0.14729.20260
	 •	Mac: 16.56 (Build 21121100)
	 •	 iOS: 2.56 (Build 21120700)
	 •	Android: 16.0.14729.20176.

To access the Advanced Formula Environment (AFE), you may use this link or manually install if from the app:

https://aka.ms/get-afe 

To access the AFE, simply search for the “advanced formula environment” within the built-in add-ins store of Excel and install it like any other Office 
add-in:

	 •	 go the Insert Tab
	 •	 select the ‘Get Add-ins’ button
	 •	 search for “advanced formula environment”
	 •	 click the ‘Add’ button

Once the add-in is installed, you should be able to find it on your Home tab.  The Ribbon button appears as follows:
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Data Validation may be used to control what end users may input into a cell.  This may be accessed by going to the Data tab of the Ribbon, then go 
to the Data Tools group and click the Data Validation icon (ALT + A + V + V or ALT + D + L), viz.

The default setting for all cells in Excel is to allow any value (pictured).  This can be changed by changing the selection in the ‘Allow’ drop down box.  
It may be modified to any of the following:

Most of these criteria do exactly what they say on the tin: e.g. by choosing ‘Decimal’, the input must be a number, whereas ‘Whole Number’ allows 
for integers only.  However, making a selection from the ‘Allow’ drop down box is only the first part of the data validation process.

Here, let’s focus on list:

Here, typing in

North,South,East,West

will provide an in-cell dropdown box as follows:

AutoComplete for Dropdown Data Validation Lists in Excel for Windows
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A range may be used instead.  We could select a range instead, e.g.

Some time ago, we showed how to create a data validation list that will “narrow down” the list as you type in the cell using dynamic arrays.  But now, 
that’s no longer needed:

Microsoft has announced that they are speeding up data entry and validation with AutoComplete for dropdown lists, which is now available for some 
– alas, not all – users in Excel for Windows in the Beta Channel.
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This AutoComplete algorithm for dropdown list matches the string you 
type in the dropdown list cell with words from items in the dropdown 
list and then shows only the matching list items.  As you type more 
characters, the dropdown list contracts, and conversely, when you 
remove characters, it expands.  Matching words can be from anywhere 
in the list item's string – at the start, middle, or end.  Also, the dropdown 
list excludes blank items from the Data Validation dropdown list.

This helps speed-up discovery of the right Data Validation values, 
and in turn, reduces time spent scrolling through the dropdown list, 

dealing with Data Validation errors, or writing complex code to enable 
it.  Furthermore, Microsoft has added that they plan to add excluding 
duplicates from the dropdown list before it is rolled out into general 
production.

AutoComplete for Data Validation drop-down list is available in Beta 
Channel with version 2112, build 16.0.14818.10000 or later.  Not 
everyone will get it immediately though, as Microsoft monitors usage 
and bugs.  But be patient – it’s a very cool feature!

Until recently, Microsoft (and to be honest, end users too) saw Excel 
for the Web as a “consumption-based companion app to [the] desktop 
version” (to quote the software company).  This meant that you were 
limited in viewing, creating and editing charts via this medium.   However, 
it is beginning to improve, which both free and paying customers starting 
to see noticeable improvements.

For instance, since the beginning of February, you may now leverage the 
Format task pane and on-chart interactions to format charts in Excel for 
the Web.  The Format pane provides formatting support for critical chart 
properties (axes, legend, data series, etc.) and makes it easy to view and 
navigate to each editable chart element.  You are now able to make 
property edits to elements of a chart such as the fill / outline colour, 
number format, axis bounds, and so forth.

Further, you may now also select the individual elements within a chart 
directly, in order to launch and navigate to their respective formatting 
options in the Format pane.  Previously, you could only select the entire 
chart but not any contents within the chart.

To explore these new capabilities, launch the task pane by double-
clicking anywhere on the chart or by right-clicking and selecting ‘Format’.  
From there, you can view each chart element’s formatting options by 
either selecting an element within the chart or expanding the options in 
the Format pane.

You may now also add and remove chart elements without having to 
leave the Format pane.  Users can leverage the new on / off toggles in 
the pane to choose whether to include a chart element in the chart.  

Alternatively, you may use the delete / backspace keys to remove a 
chart element that is selected.  Support has also been added for adding 
/ removing trendlines and error bars.

New Features for Charting in Excel for the Web
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These are not the only improvements:

	 •	 you may now select data from non-adjacent rows to create a chart.  Previously, you were limited to creating charts from a continuous range 	
		  of cells:

	 •	 you may now freely change between all different chart types.  Previously, some chart type changes were not supported

	 •	undo / redo support has also been added for all chart commands and enabled sheet duplication for worksheets containing any chart type.

More in time, for sure.
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There is a new side pane coming to Excel for the Web.  Now, you may manage the rules whilst seeing the formatting result on the grid.  All you have 
to do is hover the mouse pointer over a rule to see the range it refers to:

You may manage the rules for the current selection or the entire sheet with a dropdown:

In addition to managing rules, you may also edit or add new ones in Excel for the Web.  For example, to edit a rule, click on the Edit button in the 
side pane.  

To add a new rule, click on the ‘New Rule’ button in the side pane or use the ‘Conditional Formatting’ menu in the Ribbon.

New Conditional Formatting Experience in Excel for the Web
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In the new rule editor, you will find the familiar rule types like those in Excel Desktop:

You may use the dropdowns to specify the criteria and choose a format. 
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New rule types have been added to Excel for the web, thus closing the gap to Desktop just that little bit more:

	 •	Greater than or equal to 
	 •	 Less than or equal to 
	 •	Not containing 
	 •	Beginning with 
	 •	 Ending with 
	 •	Blank / No blanks 
	 •	 Errors / No errors 
	 •	 Formula: you may now specify the formatting criteria using a logical formula in Excel for the Web.  This rule type gives you the added  
		  flexibility of formatting a range based on the result of a function or evaluate data in cells outside the selected range.

There is more coming soon to Conditional Formatting in Excel for the Web too: 

	 •	 Reorder rules with drag and drop 
	 •	 Change the range the rule refers to in the rule manager 
	 •	 Custom formatting.

July last year saw the release of a new Excel Trust Center (sic) setting option to restrict the usage of Excel 4.0 (XLM) macros.  From mid-January 2022, this 
has been made the default setting when opening Excel 4.0 (XLM) macros.  This is to assist users in protecting themselves against related security threats.

This setting may be managed by visiting the Excel Trust Center in File -> Options, viz. 

File -> Options -> Trust Center -> Trust Center Settings -> Macro Settings

Excel 4.0 Macros Now Restricted by Default
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This setting now defaults to Excel 4.0 (XLM) macros being disabled in Excel (Build 16.0.14427.10000).  It should also be noted that administrators 
may also use the existing Microsoft 365 applications policy control to configure this setting. 

The Group Policy setting ‘Macro Notification Settings’ for Excel may be found in the following path and registry key:

	 •	Group Policy Path: User configuration -> Administrative templates -> Microsoft Excel 2016 -> Excel Options -> Security -> Trust Center
	 •	Registry Key Path: Computer\HKEY_CURRENT_USER\SOFTWARE\Policies\Microsoft\Office\16.0\excel\security.

Administrators also have the option to completely block all XLM macro usage (including in new user-created files) by enabling the Group Policy, 
‘Prevent Excel from running XLM macros’, which is configurable via Group Policy Editor or registry key.

XLM is disabled by default in the September fork, version 16.0.14527.20000+

	 •	Current Channel builds 2110 or greater (first released in October 2021)
	 •	Monthly Enterprise Channel builds 2110 or greater (first released in December 2021)
	 •	 Semi-Annual Enterprise Channel (Preview) builds 2201 or greater (created in January 2022, but not shipping until March 2022)
	 •	 Semi-Annual Enterprise Channel builds 2201 or greater (will ship July 2022).

With many of us currently “working from home” / quarantined, there are 
only so Zoom / Teams calls and virtual parties you can make before you 
reach your (data) limit.  Perhaps they should measure data allowance 
in blood pressure millimetres of mercury (mmHg).  To try and keep our 

readers engaged, we will continue to reproduce some of our popular Final 
Friday Fix challenges from yesteryear in this and upcoming newsletters.  
One suggested solution may be found later in this newsletter.  Here’s this 
month’s…

When building a financial model, time series are important, and most people know how to build them when each column represents a year, a 
month or any time period with at least a day in length (if you don’t, it is highly recommended that you take our Financial Modelling course smile-beam).  
Here is such an example:

But what do you do when you want a time period that is less than a day, with dynamic blocks of hours, like the one below:

When you change the inputs, the time series automatically updates:

This month’s challenge is to create a formula that will propagate the illustrated Date and Hour rows, when the number of days and the number of 
blocks per day may be varied.

Sound easy?  Try it.  One solution just might be found later in this newsletter – but no reading ahead!  

Beat the Boredom Challenge
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It’s time to chart our progress with an introductory series into the world of creating charts and dashboards in Excel.  This month, we look at Sunburst charts.

The Sunburst chart is an advanced version of the Doughnut (Donut) 
chart, which enables the mapping of hierarchical data.  The innermost 
ring of a Sunburst chart represents the data at the top of the hierarchy, 
and each ring outside of it depicts the next level down and therefore a 
breakdown of the previous inner ring.

To create a Sunburst chart, the first stage is obviously to organise the 
source data.  The number of columns required is determined by the 
number of levels in your data hierarchy plus one extra column on the 
right for the values.  If you have three levels of hierarchy, then you will 
need four columns, as an example below:

With the data table organised, we may then proceed to create the 
Sunburst chart.  As usual, we may select the source data and the column 
headings, excluding the table heading, and go to the Insert tab.  Then, 
select the Sunburst chart from the small middle icon across the top row 

of the Charts section or through the ‘Recommended Charts’ icon or the 
small arrow in the bottom right corner or the Charts section.  Unlike all 
the other charts we’ve reviewed so far, there is only one type of Sunburst 
chart available in Excel.

The chart initially appears like this:

Charts and Dashboards
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Depending on the physical size of the chart, the size of the segments 
and the length of the data labels involved, Excel will do its best to fit as 
many labels as it can onto the chart.  As you can see, for the Vehicle Fleet 
Costs, only the Fuel and Registration are labelled as the other slices are 
too small and / or the labels are too long for Excel to fit the text inside 
the segments.  

You should also note that Excel automatically ordered the categories and 
the expense accounts within each category from highest to lowest before 
plotting the information.  Like a Pie Chart, the first segment commences 
from the highest point of the chart with the segments ordered clockwise.  
As Operational Costs is the biggest expense group, it was mapped first, 
followed by the Other Business Costs and lastly the Vehicle Fleet Costs.  

Also, looking at the outer ring, Rent was the biggest item in Operational 
Costs, followed by Outgoings then Cleaning, etc.

Most of the standard formatting options available in other charts are 
applicable to Sunburst charts.  However, due to Excel automatically 
sorting categories, the order of the segments in this chart cannot be 
changed.  Also, I cannot choose the angle for the first slice or “explode” 
out any pieces of the Sunburst chart.

I can add amount labels to the segments by clicking on the data labels, 
right-clicking and choosing ‘Format Data Labels’, then ticking the Value 
box and changing the Separator to be ‘New Line’.

Unfortunately, where the data labels do not fit in the chart segments, you won’t see the figures associated with them either.  Also, only the lowest level 
of the data hierarchy, being the outermost ring of the chart, will display values.  The higher level categories / inner rings do not show sub-totals or totals.  

Finally, we may set the fonts and lines to black, enter a Chart Title and format the Chart Area to complete the chart:

More next month…
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We thought we’d run an elementary series going through the rudiments of Visual Basic for Applications (VBA) as a springboard for newer users.   
This month, we continue looking at using ListObjects to manipulate Tables within an Excel workbook in VBA, this time featuring ListColumns.

The ListColumns property allows us to manipulate columns within a table.  Say we have the following table, with the table name of ‘Table1’:

We can select a specific column in a table using the following code in VBA:

Dim Tbl As ListObject

Set Tbl = Range("Table1").ListObject

Tbl.ListColumns(1).Range.Select 

If we just want the data in a specific column, we may use this VBA code:

Set Tbl = Range("Table1").ListObject

Tbl.ListColumns(1).DataBodyRange.Copy 

From here, we can copy and paste the column with this code.

That’s not the only thing we can do with ListColumns; we may also add columns.  The following VBA code will insert a column at the end of the table:

Set Tbl = Range("Table1").ListObject

Tbl.ListColumns.Add

Furthermore, we can specify exactly where we want the new column by adding “Position:=2” at the end of the previous code:

Tbl.ListColumns.Add Position:=2

Our example table now looks like this:

More next time.

Visual Basics
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We continue our series on the Excel COM add-in, Power Pivot.  This month, we consider when to use fully qualified names.

Each month we’ll reproduce one of our articles on Power Query (Excel 2010 and 2013) / Get & Transform (Office 365, Excel 2016 and 2019) from  
www.sumproduct.com/blog.  If you wish to read more in the meantime, simply check out our Blog section each Wednesday.  This month, look at how 
to use the M function List.Accumulate.

We've touched briefly on fully qualified names or column references before.  However, we thought we should take this opportunity to expand on 
fully qualified names and when they are required. 

Just to recap, a fully qualified name of a column is the 'Table Name' followed by the [Column Name] encapsulated by square brackets:

=’Product SubCategory’[Standard Cost]

DAX requires a fully qualified name to be used whenever a column reference is used as:

	 •	 an argument in the VALUES function
	 •	 an argument in the ALL or ALLEXCEPT function
	 •	 a filter in the CALCULATE function
	 •	 an argument in the RELATEDTABLE function
	 •	 an argument in any time intelligence function (e.g. DATEADD, TOTALYTD).

Generally, it is always a good idea to use the fully qualified name whenever we are referring to columns, so don't be lazy!

A separate point that we wish to address is the single quotation marks that encapsulate the table name 'Product SubCategory'. 

 =’Product SubCategory’[Standard Cost]

The table name above is enclosed in single quotation marks because the table name contains a space.  This referencing convention is also applicable 
to tables with reserved keywords (such as DATE_START), similarities with DAX functions or special characters (.,;':/\*|?&%$!+=()[]{}<>). 

More Power Pivot Principles next month.

The List.Accumulate function can transform data by performing several steps at once.  This certainly sounds useful, although the description in the 
Microsoft help pages sounds a little intimidating:

“…Accumulates a result from the list.  Starting from the initial value seed, this function applies the accumulator function and returns the final result…”

List.Accumulate(list as list, seed as any, accumulator as function) as any

where:

	 •	 list = the list to check
	 •	 seed = the initial value seed
	 •	accumulator = the value accumulator function.

The purpose of this function is to take a list, look at each item in the list and then do something with those items and sew a seed.  What I need are 
examples of how to use this function!  This month, we will look at examples where the ‘seed’ is usually set to zero [0], namely summing (where ‘seed’ 
must be zero) and counting.  Next newsletter, we’ll move onto examples where the ‘seed’ is not zero.

Power Pivot Principles

Power Query Pointers

Summing

Now we know there is a List.Sum function!  In fact, that very function is used in Power Query: One Route to a Running Total.  However, this is another 
way to sum the items in a list, and it will help to explain how List.Accumulate works.  Let’s start with a simple list:
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We are going to create a new blank query from the ‘Other Sources’ option of ‘New Query’ in the ‘Get and Transform’ section on the ‘Data’ tab.  We 
are simply going to sum the items in this list:

That’s just to prove this is the same as List.Sum (the purpose-built function)!

The syntax for the List.Accumulate sum is:

= List.Accumulate(Simple_List, 0, (state, current) => state + current)

which essentially loops through my list looking at the ‘current’ value and the ‘state’ (in this case the value of the total so far):

							       Current		  State		  State + Current

							       10		  0		  10

							       20		  10		  30

							       30		  30		  60	

							       40		  60		  100

							       50		  100		  150

							       60		  150		  210

							       70		  210		  280

							       80		  280		  360

							       90		  360		  450

							       100		  450		  550

The accumulator, or value accumulator function is an example of what is known as a lambda function.  Just like in Excel, lambda is a bit like algebra 
for programming.  The examples used here involve simple lambda functions.  The ‘seed’ is the starting value for the ‘state’ – which here is zero [0], 
so that the sum adds up correctly.  If we used ‘seed’ one [1], then the final amount would be 551 instead.
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Counting

The simplest count is to count the number of items in a list.  We may use our previous list for this.  Let’s create a new blank query for the List.
Accumulate function. 

We may then compare the results to List.Count:

This time the function is simple:

= List.Accumulate(Simple_List2, 0, (state,current) => state+1)

						      		  Current		  State		  State+1

								        10		  0		  1

								        100		  1		  2

								        20		  2		  3

								        50		  3		  4

								        100		  4		  5

								        30		  5		  6	

								        40		  6		  7

Changing the ‘seed’ would offset the count by the value in the seed, so we would keep it as zero [0].  However, we could tweak this function to count 
how many items were 100 (say) quite easily:

= List.Accumulate(Simple_List2, 0, (state,current) => if current = 100 then state+1 else state)
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We could also use similar functionality on a list of text items.  Below, we want to count the number of items that have the word ‘tent’ in them:

Let’s use List.Accumulate to achieve this:

The functionality we have used is:

= List.Accumulate(Simple_List4, 0, (state,current) => if Text.Contains(current, Text.Lower("tent")) then state +1 else state)

In other words, count if ‘tent’ is found in the text.  Lowercase is not strictly necessary in this example, but it’s a good idea to always convert to 
lowercase when making text comparisons.

This example shows how easy it is to adapt the List.Accumulate function to achieve a specific result.  

More next month!
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…And so they are back!  The raft of 2022 Power BI updates starts here, with a slew of new features, including new mobile formatting options, 
Dynamic M Query Parameters support for more data sources, deployment pipeline enhancements and improvements to downloading a PBIX file.  
But there are of course always more. 

The full list is as follows:

Power BI Updates

Reporting

	 •	 New Mobile formatting options in Preview
	 •	 Sensitivity labels downstream inheritance now Generally 	 	
	 	 Available
	 •	 Default label policies in Power BI now Generally Available
	 •	 Mandatory label policy now Generally Available
	 •	 New Format Pane, still in Preview, is now on by default
	 •	 Multi row card selection

Data Preparation

	 •	 Dynamic M Query Parameters now supports SQL Server and 	 	
	 	 more data sources in Preview

Data Connectivity

	 •	 Amazon OpenSearch Service (New Connector)
	 •	 OpenSearch Project (New Connector)
	 •	 Digital Construction Works Insights (New Connector)
	 •	 Azure Databricks (Connector Update)
	 •	 BQE Core (Connector Update)
	 •	 MicroStrategy (Connector Update)
	 •	 Starburst Enterprise (Connector Update)

Service

	 •	 Power BI Goals
	 	 	 o	 Notifications
	 	 	 o	 Multiple Owners
	 	 	 o	 My Workspace
	 •	 Deployment pipelines enhancements
	 •	 Download .pbix improvements

Mobile

	 •	 Dark mode now available in the Power BI Windows app
	 •	 Power BI Windows app new look now Generally Available	
	

Embedded Analytics

	 •	 Support Power BI dataset as a data source for embedding 	
	 	 paginated reports
	 •	 Azure Power BI Embedded A7 and A8 capacity nodes self-service
	 •	 New Dataset Permissions APIs
	 •	 Delete Dashboard API
	 •	 Access Token Expiry Callback

Developers

	 •	 New Power BI visuals’ category list in AppSource
	 •	 Expand entire level in matrix
	 •	 Dynamic format string support

Visualisations

	 •	 New visuals in AppSource
	 •	 Download visual’s sample file from the in-product AppSource
	 •	 Drill Down Graph PRO by ZoomCharts
	 •	 Plotly.js visual by Akvelon
	 •	 HTML Text Styler 2.0 (Microsoft certified)
	 •	 Multiple Sparklines by Excelnaccess.com
	 •	 Merged Bar Chart by Nova Silva
	 •	 Financial Reporting Matrix by Profitbase
	 •	 Inforiver premium edition by Lumel
	 •	 Zebra BI Tables version 5.2 by Zebra BI

Other

	 •	 WebView2 now required
	 •	 Find out new features releasing in Power BI by using Power BI 		
	 	 Release Plan app
	 •	 Optimise your processes and gain deep insights with Process 	 	
	 	 Mining
	 •	 New settings to enable or disable Map and Filled Map visuals.

Let’s now go through each in turn.

New Mobile formatting options in Preview

Over the past several months, Microsoft has been working on making it 
possible to format visuals in Mobile layout, and to have those formatting 
changes affect only the Mobile-optimised view.  This update announces 
the public Preview of this major improvement to the Mobile-optimised 
report authoring experience.

To access this new Mobile formatting experience, switch on the ‘Modify 
visuals settings for Mobile layout’ Preview feature (File -> Options and 
settings -> Options -> Preview features -> Modify visuals settings for 
Mobile layout).

You should note that the Mobile app version that supports the new 
Mobile formatting feature will be released Microsoft Store only from 
mid-February (but still before this article was written!), therefore you 
will be able to create the Mobile layout in Power BI Desktop, but when 
publishing to the Service, you will not be able to either view the updated 
layout in the Service or utilise it in the app until the official feature 
release.
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Sensitivity labels downstream inheritance now Generally Available

Default label policies in Power BI now Generally Available

Downstream inheritance enables you to automatically apply a dataset’s 
or report’s sensitivity label on all downstream reports and dashboards.  
When a sensitivity label is applied to a dataset or report in the Power 

BI Service, the label will cascade down and be applied to content that 
is built from that dataset or report as well.  Downstream inheritance is 
now Generally Available.

Default label policies enable you to define a baseline level of protection 
to be applied to Power BI files and to artifacts in the Power BI Service.  
This capability is now Generally Available.

Default labelling applies when you create a new file in Power BI Desktop 
or a new dataset or report in the Power BI Service.  The default label 
is set automatically on the new file or artifact, without interfering with 
your workflow.

For example, when a label is applied to the dataset ‘Customer profitability’, that label gets applied to the dataset’s downstream content.
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Mandatory label policy now Generally Available

New Format Pane, still in Preview, is now on by default

Mandatory label policies enable organisations to ensure that Microsoft 
Information Protection (MIP) sensitivity labels will be applied to new 
content when it is created in or uploaded to Power BI.  This capability is 
now Generally Available.  When a user tries to save a PBIX file in Power 

BI Desktop, or a Power BI artifact in the Service, that doesn’t have a 
sensitivity label applied, you will be prompted to choose a label before 
the item will be saved.  Also, the option to remove a label isn’t available 
when a mandatory label policy applies.

Well this has stuffed up our latest book – re-write underway!!  It’s time to 
hunt everything out again: the new Format pane is now on by default for 

users upgrading to the latest release.  Microsoft has added a notification 
dialog to call attention to this change.

If you need to turn this preview off, you can find the preview switch from: File -> Options and settings -> Options -> Preview Features -> New format pane. 

Improvements added in this update include:

	 •	 outline settings for matrix and table have been re-added, previously missing
	 •	 ability to toggle axis title independent of axis has been re-added, previously missing
	 •	 ability to add shade area to combo charts has been re-added, previously missing
	 •	 ability to customise marker shape by series for scatter charts has been re-added, previously missing
	 •	minor reordering of the field wells within the Build pane to match the order of the new Format pane cards for pie chart, donut chart and 	
		  scatter chart.
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Multi row card selection

You can now select rows in your multi row card to cross highlight and cross filter the other visuals in your report.  Unselected rows will dim to help you 
identify which rows you have selected, and you can CTRL or SHIFT + Click to select multiple rows at once.  This brings interactivity in multi row cards 
closer to parity with other visual offerings.

Dynamic M Query Parameters now supports SQL Server and more data sources in Preview

Amazon OpenSearch Service (New Connector)

OpenSearch Project (New Connector)

Digital Construction Works Insights (New Connector)

When Dynamic M Query Parameters was released, the feature supported M-based data sources (such has Azure Data Explorer, Databricks, BigQuery, 
Snowflake and more) but did not support other sources like SQL Server.  This month, Dynamic M Query Parameters now supports more DirectQuery 
data sources including:

	 •	 T-SQL based data sources: SQL Server, Azure SQL Database, Synapse SQL pools (such as Azure Synapse Analytics) and Synapse SQL  
		  OnDemand pools
	 •	Oracle
	 •	 Teradata
	 •	Dataflows (enhanced compute engine enabled)
	 •	 SAP Hana Relational.

As a reminder, Dynamic M Query Parameters is the Preview feature that allows report viewers to dynamically set the value(s) for an M Query 
Parameter using filters or slicers.  This feature may be especially useful for query performance optimisations without sacrificing report interactivity.

The new Amazon OpenSearch Service connector is now available.  
Amazon OpenSearch Service now supports integrating with Microsoft 
Power BI.  Powered by the OpenSearch ODBC Driver you can now 
integrate your Microsoft Power BI environment with your Amazon 
OpenSearch Service domains using the OpenSearch SQL Engine.

The OpenSearch SQL Engine uses Structured Query Language (SQL) to 
manifest search results in a tabular format.  One of the key features 
of this engine is the Open Database Connectivity (ODBC) driver which 

enables you to integrate various business intelligence (BI) and analytics 
applications with OpenSearch, to create sophisticated, informative 
data visualisations on top of the search results obtained from Amazon 
OpenSearch Service by leveraging the Power BI Integration, to provide 
data insights.

Amazon OpenSearch Service Power BI integration is powered by 
OpenSearch, an Apache 2.0-licensed project.

That’s not all.  There is also the new OpenSearch Project connector by 
Amazon too.   The OpenSearch SQL Engine again uses Structured Query 
Language (SQL) to manifest search results in a tabular format.  Similar 
to the last connector, you may create sophisticated and intelligent data 
visualisations with this tool too.

And again, OpenSearch project Power BI integration is powered by 
OpenSearch, an Apache 2.0-licensed project.

Next up is the new Digital Construction Works Insights connector.  This 
connector works with data from your Data Construction Works (DCW) 
Integrations Platform Organizational (sic) and Project Data Warehouses.  

It enables you to query all of your project data via one single source and 
build impressive visuals and reports. 
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The DCW Insights connector works using a standard OData V4 connection 
to your DCW Platform API subscription.  This connector allows you to 

query your project data via one single source.  Simply enter the project 
URL in the connectors configuration screen and click OK.

Then, enter in your unique platform project API key to securely connect to your project.  Data will be returned, and you will be able to build your 
visualisations and reports at will.  You may refresh your reports automatically, keeping your construction and project scheduling dashboards up to date.

Azure Databricks (Connector Update)

BQE Core (Connector Update)

MicroStrategy (Connector Update)

Starburst Enterprise (Connector Update)

Power BI Goals

NOTIFICATIONS

Goal assignment notifications

This update of the Azure Databricks connector adds the ability to provide custom SQL queries, by using the Power Query function ‘Databricks.Query’.

The BQE Core connector has been updated.  Users now have access to the budgetId field in Projects, which allows you to identify the budget linked 
to a project.

The MicroStrategy connector has been updated. The connector (version 2.4.5) incorporates the following bug fixes / improvements:

	 •	 added support for OIDC authentication
	 •	fixed issue with path detection on Power Bi online when “/“ was not added at the end of MicroStrategy REST API URL.

The Starburst Enterprise connector has been updated.  Broken catalogs (sic) are ignored when connecting to SEP or Starburst Galaxy; previously, if 
any catalogs were broken the whole connection would fail.

This month, there are updates on Teams notifications integration, plus the ability to add multiple owners to a goal and the ability to create scorecards 
in My Workspace.  Additionally, Goals is now available in all US Government clouds.

The Power BI Teams notifications integration helps you stay up to date about the goals you’re responsible for without having to leave Teams to view 
the updates to the scorecard.  With this release, you’ll be notified when someone assigns you a goal, mentions you in a note or when the status of a 
goal you own gets updated by an automated status rule.

Goal assignment notifications are sent when an owner is assigned a goal 
or their goal is changed. The goal owner receives a Teams notification 
from the user assigning the goal if they have the Power BI app for Teams 
installed.  They will receive a notification in the activity feed and as 
a banner (known as a ‘toast card’).  When they click the notification, 

the scorecard opens and the Details pane for the goal is shown.  This 
notification will help users be aware of the goals that are assigned to 
them immediately, without relying on someone to tell them what 
scorecard their goals are on.
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Notifications for mentions

Status update notifications

These notifications help users get someone’s attention on a goal without 
having to leave the scorecard by tagging them in a note.  When a user is 
@mentioned in a note on a new or existing check-in, they get an activity 

feed notification from the note creator, which opens the Details pane 
showing the note.

This notification helps users get an immediate notification when the 
status of the goal gets updated by an automated status rule, so they don’t 
have to rely on checking their goals in the scorecards.  The owner of the 

goal gets an activity feed notification from the user who configured the 
data connection in the case of connected goals or the user who edited 
the value in the case of manual goals.

Note that you need to have the Power BI app for Microsoft Teams and the recipient needs to have access to the scorecards to get these notifications. 
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MULTIPLE OWNERS

Many have asked for the ability to add multiple owners to a single goal.  This is now possible simply by typing additional names in the owner field of 
a goal.  Presently, you may add up to five [5] owners.  These additional owners may also work with notifications and Power Automate integrations.

MY WORKSPACE

You may now create scorecards in My Workspace in Power BI, making 
it easier than ever to create and keep personal scorecards and share 

them out when they are ready.  Free users may author scorecards in My 
workspace, but a Pro license is required to share them (of course!).
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Deployment pipelines enhancements

Download .pbix improvements

Dark mode now available in the Power BI Windows app

In this update, Microsoft has released the following features for deployment pipelines:

	 •	Azure DevOps extension (Preview): automate your deployments and pipeline creation using Tasks in the Azure pipeline
	 •	multiple pipelines working together: synchronise the connections between items managed in different pipelines
	 •	Dataflows GA and support for linked entities

Microsoft has turned its attention to enabling the download of a .pbix file 
in Preview feature for more scenarios.  Previously, you were not able to 
download a .pbix file for reports when the report connected to a single 
dataset and that dataset was configured for large models, incremental 
refresh or had been modified by using the XMLA endpoint. 

Starting with this release, that limitation has been removed for reports 

that are created in Power BI Desktop and published to the Power 
BI Service, if the report connects in live mode to the dataset that has 
the properties described as limitations prior to this release.  Note that 
downloading a .pbix for such a dataset itself is not supported, nor can 
a report be downloaded if it was created on the Power BI Service and 
connects to such a dataset.

The Power BI app for Windows is designed and optimised for viewing and 
interacting with Power BI content.  In this update, support has been added 
for dark mode.  When the app is in dark mode, all screens and dialogs 
are presented in a dark theme, reducing the brightness of the screen, and 

making it easier to view it.  However, the Power BI content itself, such 
as reports and dashboards, does not change: the colours and themes 
published by the person who created the content remain the same.

You may choose between the light and dark themes in the app’s appearance settings, or you can leave the setting as “System default”, in which case the 
app will use whatever theme your operating system is using.
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Power BI Windows app new look now Generally Available

Support Power BI dataset as a data source for embedding paginated reports

Azure Power BI Embedded A7 and A8 capacity nodes self-service

Delete Dashboard API

Access Token Expiry Callback

New Dataset Permissions APIs

The Power BI Windows app new look has now become standard, and the old look is no longer available.  Starting with this update, when you open 
the Power BI Windows app, it will open directly in the new look, and you’ll land on the new home page, where you can easily find and access the 
most frequent and recent items you usually use in Power BI.

With Power BI embedded analytics, independent software vendors (ISVs) 
and customers may create Power BI content that displays paginated 
reports in a fully integrated and interactive application.  They can embed 
paginated reports using the solution that works best for end users, 
embed for customers or embed for your organisation.

Until now, Power BI dataset was not supported as a data source for those 
scenarios, but now it has been enabled.  When embedding a paginated 
report with a Power BI dataset as a data source for the embedding for 

your customer’s scenario, you will need a service principal and a multi-
resource embed token that contains a new parameter called ‘XMLA 
permissions’.  Using this parameter, ISVs and customers may control 
the access to XMLA endpoints with the embed token.  For allowing 
embedding of paginated report with a Power BI dataset as a data source 
a ‘Read Only’ value is required.

Power BI datasets with data sources that require single sign-on (SSO) are 
not supported yet, but that’s coming soon apparently.

I am going to pretend I know what I’m talking about here.  A7 is like P4 
capacity node, carrying 64 v-cores and 200GB RAM.  A8 is like P5 capacity 
node, carrying 128 v-cores and 400GB RAM.  Both capacity nodes could 
be purchased by special request only, and now Microsoft has enabled 

their purchase in self-service, either through the Azure Portal or using 
an ARM API.

Self-service purchase of A7 and A8 in sovereign cloud will be enabled 
later this year.

You can now programmatically delete dashboards from your workspaces using the deleteDashboard and deleteDashbordInGroup APIs.

Embedding Power BI artifacts requires the use of access tokens, which 
have an expiration time and must be refreshed before expiration to allow 
a continuous embedding experience.  When using an Azure AD token 
for the embed for your organization scenario, this can now be done 
automatically by setting an event hook in your embedding configuration 
parameters which will call a function responsible for generating new 

tokens and assign the generated token to the embedded artifact before 
the expiration of the token.

With this new configuration, all you need to do is provide the token 
generating function, and the rest will be taken care of automatically so 
that your users will get a fluent and continuous experience.

The dataset permissions application programming interfaces (APIs) are a set of APIs that allow you to easily manage the permissions of your datasets 
to allow users to perform read, reshare and explore (build) operations.  This lets you manage your datasets not only through the Power BI Service, 
but also through your application.

The APIs that are currently supported are POST and PUT:

	 •	 The POST API allows you to grant new permissions to a dataset.  It 	
		  requires having read and reshare permissions for the dataset and 	
		  all the permissions you wish to grant.  Keep in mind that the POST 	
		  API cannot be used for deleting permissions, and that calling the 	
		  API with permissions which the target already has will have no 		
		  effect

 
	 •	 The PUT API lets you update the target’s permissions to a given 	
		  dataset.  It requires having read, write and reshare permissions 	
		  for the dataset and all the permissions you wish to update.  		
		  The PUT API cannot be used for changing write permissions or any 	
		  folder level inherited permissions. This API also supports removing 	
		  all permissions for a dataset for a given target.
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New Power BI visuals’ category list in AppSource

Expand entire level in matrix

Download visual’s sample file from the in-product AppSource

Dynamic format string support

New visuals in AppSource

You may now login to Partner Center (sic) and retag your visuals with the new categories.  The revised category list has more, easier to understand 
options to help report authors find a suitable visual easily and quickly.

You should note that you can tag a visual with up to two categories from the list.  If your visual was previously tagged with a category that has been 
removed, you should update your visual with a new one.

With the 4.2 API release you may expand / collapse entire level programmatically.  You should note that if you need to expand a large number of data 
points, you can use the ‘fetch more data’ API with the expand / collapse API.

Now you may click on ‘Download Sample’ from the visual page in the 
in-product AppSource and download a sample Power BI report created 
by the visual publisher.  The sample report demonstrates what the visual 

looks like and how it may be used.  It can also include useful comments, 
tips and tricks from the publisher.

It is available from API 4.2.

In order to support dynamic format string in your custom visual, add the following definition to capabilities.json:

The following are new visuals this update:

	 •	 Line with Bubble Chart
	 •	 Custom Tree View with Bar Chart
	 •	 Custom Slicer
	 •	Bar Chart with Top N Selection
	 •	Merged_Bar_Chart
	 •	 Clustered Stack Chart
	 •	 100% Stacked Column chart with value label (Not %)

	

	 •	Bullet_Chart	
	 •	Ultimate Upset Plot
	 •	 Lollipop Column Visual
	 •	 Line Dot Chart
	 •	Overlapped Bar Chart
	 •	 Scatter Plot with Line marks (instead of Dots)
	 •	 Power ON Visual Planner Service.

	 •	 Comparison
	 •	Correlation
	 •	Distribution
	 •	 Flow
	 •	 Filters

	 •	 Infographics
	 •	 KPIs
	 •	Narratives
	 •	Maps
	 •	 Part-to-Whole

	 •	R visuals
	 •	 Change over time
	 •	Other.

"objects": {
"general": {
"properties": {
"formatString": {
"type": {
"formatting": {
"formatString": true
}
}
}
}
},

The new categories are:
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Drill Down Graph PRO by ZoomCharts

Plotly.js visual by Akvelon

Drill Down Graph PRO is a true graph visual for Power BI.  Now you can 
build networks and explore relations among data points, identify outliers 
and discover patterns, all whilst utilising navigation, cross-chart filtering 
and various customisation options.

Drill Down Graph PRO is Mobile friendly and supports interactions, 
selections, custom and native ToolTips, filtering, fetching more data, 
bookmarks and context menus.

Main features include:

	 •	multiple graph layout options
	 •	on-chart interactions
	 •	 focus node support
	 •	Auras
	 •	Cross-Chart Filtering
	 •	multiple node selection.

Most popular use cases include for:

	 •	Banking & Finance: transactional data, AML analysis
	 •	 Information Technologies: asset management, IT infrastructure,  
		  IoT monitoring
	 •	Cybersecurity & Risk Management: business process analysis,  
		  attack vector prevention
	 •	 Logistics & Transportation: fleet management, stock management,  
		  parcel tracking
	 •	 Sales & Marketing: community detection, commercial account  
		  management, web analytics and more.

It is available in AppSource.

This visual allows data scientists to create custom sophisticated charts in Power BI.  The visual allows users to view their data by using Plotly.js 
capabilities and provides a chart editor to create and customise more than 40 types of charts in Power BI.  Plotly.js community members may start 
using Plotly.js visual in Power BI with support for new chart types in the Power BI community, such as:

	 •	 Contour Plots
	 •	 2d Density Plots
	 •	 Ternary Plots
	 •	Ribbon Plots
	 •	 3D Surface Plots
	 •	 3D Scatter Plot
	 •	 3D Mesh Plots
	 •	 3D Line Plots.

3D charts help present complex data, bringing an extra dimension to Power BI’s visualisation capabilities.
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HTML Text Styler 2.0 (Microsoft certified)

Multiple Sparklines by Excelnaccess.com

The HTML Text Styler is now Microsoft certified.  This means that 
Microsoft has inspected the source code of the visual and confirms that 
it is safe to use.  For the end-user this means that the visual can now be 
exported to PDF and PowerPoint from Power BI Service and that it is also 
displayed in e-mail subscriptions.

With the combination of DAX and HTML, it is possible to create all kind 
of dynamic and cool elements in Power BI.  It may be used for custom 
KPI cards, fully formatted tables, dynamic text, animated GIFs and much 
more.

Many new features were added to ‘Multiple sparklines’ since its initial release last May.

Now you may add a line plus column chart or a double line chart as a micro chart (sparkline).  If you choose ‘Chart Type’ as ‘Double Line’, you can also 
conditionally colour the area between them.

1. COMBO CHART MENU
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2. CONDITIONAL COLOURING

You may insert a vertical waterfall sparkline.  You can set a bar as ‘pillar’ or ‘variance’ by right-clicking the cell as shown below:

Dumbbell or Range Bar graphs are useful for illustrating change and comparing the distance between two groups of data points.  You can create this 
chart just like a Bullet chart.  You need to have two [2] columns (start values and end values) against each category.

3. WATERFALL CHART

4. DUMBBELL CHART
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5. WAFFLE CHART AND RATINGS CHART

Now you can add customised headings for Combo chart and Bullet charts.

Available in AppSource.

6. CUSTOMISED HEADINGS

mailto:contact@sumproduct.com
http://www.sumproduct.com


contact@sumproduct.com  | www.sumproduct.com  | +61 3 9020 2071 

Merged Bar Chart by Nova Silva

Financial Reporting Matrix by Profitbase

On initial inspection, the Merged Bar chart has a lot of similarities with small multiples.  The key difference is the way these charts allow you to 
compare values.  The Merged Bar chart focuses on comparing multiple measures (like EBITDA and market capitalisation in the example below) within 
one specific categorical variable (here, Industries of S&P 500 stocks).

With the Financial Reporting Matrix, you can develop and maintain your reports in one place using JSON, embed formulas, styling and formatting in 
a JSON-string, speeding up the process of building your reports, while requiring a minimum of DAX.

This is particularly useful if you want to ensure consistency across multiple reports with the same layout.

Based on Power BI user feedback, several new features have been added 
to this visual:

	 •	 conditional formatting: bars within a measure can change colour 	
		  (the example above shows the EBITDA / FTE in red when it  
		  concerns a negative revenue growth)

	 •	data labels: besides the bar, you can show the data label.  You 		
		  may even change the location of the labels

	 •	partial highlighting: when your selection results in a partial match 	
		  (in the example above, this is the selection of Washington State),  
		  the partial highlight will display this with the highlighted colour.

You can try the Merged Bar chart now by downloading it from the 
AppSource.  All features are available for free to evaluate within Power 
BI Desktop.
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JSON allows you to centrally control reports across your organisation such as:

	 •	 reports have the same structure
	 •	 KPI or ratios calculations are consistent
	 •	 correct format strings per row
	 •	highlight important rows using styling.

You may change all reports at once:

	 •	 add a new KPI or ratio in the source and it appears in all reports
	 •	 change a calculation and the change happens in all reports.

After the groundwork is done using JSON, you are still free to build on top of that using the full flexibility of the Financial Reporting Matrix:

	 •	 adding custom rows
	 •	 applying company / customer specific themes
	 •	 expand / collapse columns
	 •	 conditionally hide columns,

Again, this is available from AppSource.

Inforiver premium edition by Lumel

Inforiver delivers a quick way to build reports in Power BI.  The 
Inforiver Premium edition includes everything available in Standard 
and Professional editions (such as number formatting, calculated rows 
& columns, notes and annotations, conditional formatting and in-cell 
visualisations), plus new capabilities such as manual data capture / 

inputs for budgets / forecasts, advanced what-if simulations, formatted 
and paginated exports to PDF and Excel, blended measures, and more.

These additional capabilities can assist with sales planning, financial 
budgeting, operations forecasting and so on.
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Zebra BI Tables version 5.2 by Zebra BI

The 5.2 version of Zebra BI Tables visual brings the ability to look at 
multiple plans and forecasts, bookmark most of the settings, and other 
improvements that empower you to create actionable and insightful 
reports.

With Multiforecast and Multiplan functionality of Zebra BI Tables 5.2, 
you can add up to three [3] measures for Forecast and / or Plan, and 
compare several values against your performance to always stay flexible 
and agile:

	 •	 Zebra BI automatically adds calculations for absolute and relative 	
		  variances for each value that you add
	 •	 everything remains flexible
	 •	 visualise each measure with a different chart type, where Zebra 	
		  BI distinguishes between the measures with slight moderations of 	
		  the chart pattern.

BOOKMARKABLE SETTINGS

WebView2 now required

Find out new features releasing in Power BI by using Power BI Release Plan app

From now on, you can select the settings you want to bookmark and save the view to make it easier for the report viewers to check the report page 
most relevant to them.  You may apply this to different chart settings, layouts, titles, data labels and design options.

As announced in October, starting with this release, Power BI will now require WebView2 to be installed on your machine.

Microsoft has announced a new template app that describes new 
features releasing in Power BI.  That’s very useful!

The Power BI Release Plan app visualises features from the Dynamics 
365 and Microsoft Power Platform release plans, making it easier for 

organisations to track monthly releases and to stay up to date with 
upcoming features.  With searchable text and direct links to feature 
details, organisations may now plan better for each Power BI release 
(and we may not get so caught out with our book!).

This Power BI Release Plan app is brought to you by the Power BI team and is available on AppSource.
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Optimise your processes and gain deep insights with Process Mining

New settings to enable or disable Map and Filled Map visuals

Now with the Preview of process mining in Process Advisor, which leverages Power BI Embedded, you can use your business data to produce 
analytics and detailed process maps, gleaning new insights into ways to optimise your business processes.

When a user is not signed in, the visuals will be enabled based on a new setting in File -> Options and Settings -> Options -> Global -> Security named 
‘Use Map and Filled Map Visuals’.

Just like with new tenants, new Power BI users will need to explicitly opt in to using these visuals.  Otherwise, attempting to create a map visual will 
prompt users to enable them in their settings.

Also back in October, it was also announced that Power BI was introducing 
a tenant-level setting to enable or disable Bing Maps visuals for all users 
signed in on that tenant.  This setting was made available in the Admin 
Portal on the Service, and new tenants from then on were required to 
explicitly opt-in to the Bing Maps service before the Map and Filled Map 
visuals can be used.  Microsoft mentioned that these changes would 
make their way to Power BI Desktop in a future release, and that until 
then, report authors may see inconsistencies between what they can see 

in Power BI Desktop and what their users can access on the Service.

This release aligns the behaviours between Desktop and Service.  When a 
user is signed in on Power BI Desktop, the Map and Filled Map visuals will 
be enabled or disabled based upon their organisation’s Admin settings.  
If a user on Power BI Desktop attempts to view a Map visual when their 
tenant has not enabled the feature, they will be prompted to ask their 
admin to enable it:
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Normal service has been resumed.  More of the same next month, we’re sure!!

An imaginary number is a complex number that can be written as a real number multiplied by the imaginary unit i (sometimes denoted j) which is 
defined by its property i2 = −1.  In general, the square of an imaginary number bi is −b2.  For example, 9i is an imaginary number, and its square is −81.  
Zero is considered to be both real and imaginary. 

An imaginary number bi can be added to a real number a to form a complex number of the form a + bi, where the real numbers a and b are called, 
respectively, the real part and the imaginary part of the complex number.

Just like the Excel function ABS measures the “distance” between a number and zero (0) (e.g. ABS(-5) is five (5) units from zero (0), therefore, ABS(-5) 
= 5), so IMABS(“a + bi”) measures the distance from zero (0) to the point z = a + bi.  As can be clearly seen in the diagram, this distance is given by 
Pythagoras’ Theorem

 

Technically, IMABS returns the absolute value, or modulus, of a complex number a + bi, provided the number has been provided in said text format.

The IMABS function employs the following syntax to operate:

IMABS(inumber)

The IMABS function has the following argument:

	 •	 inumber: this is required and represents the complex number for which you want the absolute value.

The A to Z of Excel Functions: IMABS
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It should be further noted that: 

	 •	 you should use COMPLEX to convert real and imaginary coefficients into a complex number
	 •	 IMABS recognises either the i or j notation
	 •	 if the complex number ends in +i or -i (or j), i.e. there is no coefficient between the operator and the imaginary unit, there must be no space, 	
		  otherwise IMABS will return an #NUM! error.

Please see our example below: 

An imaginary number bi can be added to a real number a to form a complex number of the form a + bi, where the real numbers a and b are called, 
respectively, the real part and the imaginary part of the complex number.

The IMAGINARY function really does exist, and it returns the imaginary coefficient of a complex number in the form a + bi.

The IMAGINARY function employs the following syntax to operate:

IMAGINARY(inumber)

The IMAGINARY function has the following argument:

	 •	 inumber: this is required and represents the complex number for which you want the imaginary coefficient.

It should be further noted that: 

	 •	 you should use COMPLEX to convert real and imaginary coefficients into a complex number
	 •	 IMAGINARY recognises either the i or j notation
	 •	 if the complex number ends in +i or -i (or j), i.e. there is no coefficient between the operator and the imaginary unit, there must be no space, 	
		  otherwise IMAGINARY will return an #NUM! error.

Please see our example below: 

The A to Z of Excel Functions: IMAGINARY
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The A to Z of Excel Functions: IMARGUMENT

The IMARGUMENT function returns the argument      (theta), an angle expressed in radians, such that:

 

The IMARGUMENT function employs the following syntax to operate:

IMARGUMENT(inumber)

The IMARGUMENT function has the following argument:

	 •	 inumber: this is required and represents the complex number for which you want the argument     .

It should be further noted that: 

	 •	 you should use COMPLEX to convert real and imaginary coefficients into a complex number
	 •	 IMARGUMENT recognises either the i or j notation
	 •	 if the complex number ends in +i or -i (or j), i.e. there is no coefficient between the operator and the imaginary unit, there must be no space, 	
		  otherwise IMARGUMENT will return an #NUM! error
	 •	 IMARGUMENT is calculated as:

 

		  where:

  					               and

		  z = x + yi.

Please see our example below: 
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The A to Z of Excel Functions: IMCONJUGATE

In mathematics, the complex conjugate of a complex number is the number with an equal real part and an imaginary part equal in magnitude but 
opposite in sign.  For example, (if a and b are real, then) the complex conjugate of a + bi is a – bi.

The product of a complex number and its conjugate is a real number, a2 + b2.  

Complex conjugates are important for finding the roots of polynomials.  According to the complex conjugate root theorem, if a complex number is a 
root to a polynomial in one variable with real coefficients (such as the quadratic equation or the cubic equation), so must its conjugate.

The IMCONJUGATE function returns the complex conjugate of a complex number in x + yi or x + yj text format.

The IMCONJUGATE function employs the following syntax to operate:

IMCONJUGATE(inumber)

The IMCONJUGATE function has the following argument:

	 •	 inumber: this is required and represents the complex number for which you want to calculate the conjugate.

It should be further noted that: 

	 •	 you should use COMPLEX to convert real and imaginary coefficients into a complex number
	 •	 IMCONJUGATE recognises either the i or j notation
	 •	 if the complex number ends in +i or -i (or j), i.e. there is no coefficient between the operator and the imaginary unit, there must be no space, 	
		  otherwise IMCONJUGATE will return an #NUM! error
	 •	 the conjugate of a complex number is calculated as

Please see our final example for this month below: 

More Excel Functions next month.
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Earlier, we noted that when building a financial model, time series are important.  Most people know how to build a time series when each column 
represents a year, a quarter, a month, etc.  

Here is such an example:

But what do you do when you want a time period that is less than a day, with dynamic blocks in hours, say, like the one below?  This was our challenge 
earlier in the newsletter.

The requirement was that when you change the inputs, the time series automatically updates:

Beat the Boredom Suggested Solution

Suggested Solution

First, we will prepare our ‘Daily Time Series’ sheet.  In cell J6 in our 
illustration, we use the TODAY function to get today’s date, then format 
it as a text ‘Today’ and give it the range name Today in the Name Box.  
We will also need a few inputs, being the number of days in the time 

series, the number of blocks of hours per day and the number of hours 
per day (which should be a constant, rather than a variable, assuming 
you are a resident of Earth).  These input cells are given a corresponding 
name in the Name Box, viz.
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Having all our inputs ready, we will calculate the Hour series by using 
the MOD (https://www.sumproduct.com/thought/a-modicum-of-mod) 
and SEQUENCE (https://www.sumproduct.com/thought/getting-arrays-
spilling-the-beans-on-seven-new-functions) functions.

The MOD function, MOD(number, divisor), returns the remainder after 
the number (first argument) is divided by the divisor (second argument).  
The result has the same sign as the divisor.  Here, the MOD function 
is used to set up the hour block number e.g. 0 / 6 / 12 / 18, if we are 
breaking the day into quarters.

The SEQUENCE function, SEQUENCE(rows, [columns], [start], [step]), 

allows you to generate a list of sequential numbers in an array, such 
as 1, 2, 3, 4.  For example, SEQUENCE(4) will generate the numbers 1, 
2, 3 and 4 down a column, whereas SEQUENCE(1,4) will generate the 
same sequence across a row – which is what we want.  In this case, we 
require a time series which automatically propagates across a row with a 
width of Number_of_days*Blocks_per_day, i.e. 4*3 = 12 columns, in our 
example above.  We will nest this SEQUENCE formula inside the MOD 
formula to get the width of the series:

=MOD(Today+(SEQUENCE(1,Number_of_days*Blocks_per_day)),1)

In the first part of the formula, we want to get the block separations in a day unit, hence, we need to divide the numerator by Blocks_per_day:

=MOD(Today+(SEQUENCE(1,Number_of_days*Blocks_per_day))/Blocks_per_day,1)

The series is now not starting from zero but ending at zero, while we want it to count from zero.  The trick here is we will subtract one (1) in the 
numerator part to bring it back to the normal zero starting series.  If we have a series that starts from one (1), e.g. counting the month number in a 
quarter, just add one (1) after the final close bracket.

=MOD(Today+(SEQUENCE(1,Number_of_days*Blocks_per_day)-1)/Blocks_per_day,1)

We need to multiply the series with the number of hours per day to get the correct hour block:

=MOD(Today+(SEQUENCE(1,Number_of_days*Blocks_per_day)-1)/Blocks_per_day,1)*Hours_per_day
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With the Hour series ready, we can calculate the Date series.  The Date will be filled only at the zero-hour marks.  Similarly, we use the SEQUENCE 
function to work out the actual date series; and we use the TEXT function to keep the correct date formatting:

=IF(J10#,"",TEXT(Today+(SEQUENCE(1,Number_of_days*Block_per_day)-1)/Block_per_day,"d/mm/yyyy"))

It’s true this solution requires dynamic arrays to work, but we thought we should look to the future of Excel rather than remain entrenched in the past.

Until next time.

 

Upcoming SumProduct Training Courses - COVID-19 update
Due to the COVID-19 pandemic that is currently spreading around 
the globe, we are suspending our in-person courses until further 
notice.  However, to accommodate the new working-from-home 
dynamic, we are switching our public and in-house courses to 
an online delivery stream, presented via Microsoft Teams, with 
a live presenter running through the same course material, 
downloadable workbooks to complete the hands-on exercises 
during the training session, and a recording of the sessions for 

your use within 1 month for you to refer back to in the event 
of technical difficulties.  To assist with the pacing and flow of 
the course, we will also have a moderator who will help answer 
questions during the course.

If you're still not sure how this will work, please contact us at 
training@sumproduct.com and we'll be happy to walk you 
through the process.

Location Course Date Date Duration Duration

Online (Australia) Financial Modelling 2 - 3 Mar 2022 09:00-17:00 AEDT (-1 day) 22:00-06:00 GMT 2 Days

Online (Australia) Excel Tips and Tricks 11 Apr 2022 09:00-17:00 AEST (-1 day) 23:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 12 - 13 Apr 2022 09:00-17:00 AEST (-1 day) 23:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 10 - 12 May 2022 09:00-17:00 AEST (-1 day) 23:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 17 May 2022 09:00-17:00 AEST (-1 day) 23:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 18 - 19 May 2022 09:00-17:00 AEST (-1 day) 23:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 19 - 21 Jul 2022 09:00-17:00 AEST (-1 day) 23:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 26 Jul 2022 09:00-17:00 AEST (-1 day) 23:00-07:00 GMT 1 Day

Online (Australia) Financial Modelling 27 - 28 Jul 2022 09:00-17:00 AEST (-1 day) 23:00-07:00 GMT 2 Days

Online (Australia) Excel Tips and Tricks 29 Aug 2022 09:00-17:00 AEST (-1 day) 23:00-07:00 GMT 1 Day
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Link to Others
These newsletters are not intended to be 
closely guarded secrets.  Please feel free 
to forward this newsletter to anyone you 
think might be interested in converting to 

“the SumProduct way”.

If you have received a forwarded 
newsletter and would like to receive 
future editions automatically, please 

subscribe by completing our newsletter 
registration process found at the foot of 
any www.sumproduct.com web page.

Any Questions?
If you have any tips, comments or queries 
for future newsletters, we’d be delighted 
to hear from you. Please drop us a line at 

newsletter@sumproduct.com.

Our Services
We have undertaken a vast array of 
assignments over the years, including:
· 	 Business planning
· 	 Building three-way integrated 		
	 financial statement projections
· 	 Independent expert reviews
· 	 Key driver analysis
· 	 Model reviews / audits for internal 	 	
	 and external purposes
· 	 M&A work
· 	 Model scoping
· 	 Power BI, Power Query & Power Pivot
· 	 Project finance
· 	 Real options analysis
· 	 Refinancing / restructuring
· 	 Strategic modelling
· 	 Valuations
· 	 Working capital management
If you require modelling assistance of any 
kind, please do not hesitate to contact us 
at contact@sumproduct.com.

Training
SumProduct offers a wide range of 
training courses, aimed at finance 
professionals and budding Excel experts. 
Courses include Excel Tricks & Tips, 
Financial Modelling 101, Introduction to 
Forecasting and M&A Modelling. 

Drop us a line at training@sumproduct.com 
for a copy of the brochure or download  
it directly from 
www.sumproduct.com/training.

Check out our 
more popular 
courses in 
our training 
brochure:

Key Strokes
Each newsletter, we’d like to introduce you to useful keystrokes you may or may not be aware of.  This month we thought we’d see what 
keyboard shortcuts we have LEFT to do:
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Keystroke What it does

LEFT Move one cell to the left

ALT + LEFT Back (hyperlink navigation)

CTRL + LEFT Select the last cell in the area left

SHIFT + LEFT Extend selection one cell left

ALT + SHIFT + LEFT Ungroup

CTRL + ALT + LEFT Intel Chipset: Turn screen +90 degrees; else: move active cell to previous non-adjacent area within selection

CTRL + SHIFT + LEFT Extend selection down to last cell in area left

There are c.550 keyboard shortcuts in Excel.  For a comprehensive list, please download our Excel file at
www.sumproduct.com/thought/keyboard-shortcuts. Also, check out our new daily Excel Tip of the Day feature on the 
www.sumproduct.com homepage.

Location Course Date Date Duration Duration

Online (Australia) Financial Modelling 30 - 31 Aug 2022 09:00-17:00 AEST (-1 day) 23:00-07:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 28 -30 Sep 2022 09:00-17:00 AEST (-1 day) 23:00-07:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 5 Oct 2022 09:00-17:00 AEDT (-1 day) 22:00-06:00 GMT 1 Day

Online (Australia) Financial Modelling 6 - 7 Oct 2022 09:00-17:00 AEDT (-1 day) 22:00-06:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 9 - 11 Nov 2022 09:00-17:00 AEDT (-1 day) 22:00-06:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 16 Nov 2022 09:00-17:00 AEDT (-1 day) 22:00-06:00 GMT 1 Day

Online (Australia) Financial Modelling 17 - 18 Nov 2022 09:00-17:00 AEDT (-1 day) 22:00-06:00 GMT 2 Days

Online (Australia) Power Pivot, Power Query and Power BI 7 - 9 Dec 2022 09:00-17:00 AEDT (-1 day) 22:00-06:00 GMT 3 Days

Online (Australia) Excel Tips and Tricks 14 Dec 2022 09:00-17:00 AEDT (-1 day) 22:00-06:00 GMT 1 Day

Online (Australia) Financial Modelling 15 - 16 Dec 2022 09:00-17:00 AEDT (-1 day) 22:00-06:00 GMT 2 Days


